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    Ovation Release Notes 

 
 

Installation 
 
Please consult the Installation Guide located on the Ovation Installation Media (USB Memory card) for 
details on the hardware and software installation procedure and Authorization Key registration 
process. 

 
RAVENNA users will have to install the NET-MSC-GBEX1 PCIe Ethernet card provided by Merging 

Technologies. TURN YOUR COMPUTER OFF (shut down then switch the power off). Next plug the NET-

MSC-GBEX1 card into one of the PCI-Express bus slots on your computer and turn the power back on. 
The NET-MSC-GBEX1 card will only be operational once the MassCore runtime is installed. Refer to the 
Pyramix Installation Guide for more details. 
 

• To install the Ovation software insert the Ovation Installation Media - the installation program 
should auto-start. 

• To install MassCore launch the MT Security Settings, go to the MassCore page and install the 
MassCore RunTime (a MassCore base key is required along with MassCore 64bit and a RTX64 3.0 

key). Refer to installation guide for more details. 
• Warning: Make sure that the Windows 10 version you are installing onto is supported by Ovation, 

as often updates can break the compatibility.  
All details in the separate Ovation installation guide. 

 
 
 

 

 

 

Updates 
  
Please check our Web site http://www.merging.com periodically for information, patches and 
updates. 
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Ovation v8 INSTALLER INFORMATION:  

 
 
 

Ovation v8 is compatible with the following Operating Systems 
▪ Windows 7 Professional (64bit): MassCore/RAVENNA, Native & Native/RAVENNA ASIO 
▪ Windows 10 Professional (64bit): MassCore/RAVENNA, Native & Native/RAVENNA ASIO 

 
Note: Ovation v8.0 as of RC1 is supported under the Windows 10 updates;  

• Anniversary (1607)  
• Creator (1703) 
• Fall Creator (1709) 
• Spring Creator (1803) 

• October 2018 update (1809)  

As well as the Meltdown, Spectre and Zombieload Windows updates.  
• May 2019 Update 1903/19H1 is supported as of Ovation v8.0.5 HotFix and RTX64 3.7 

 
WARNING: Ovation 8 is supported on 4th Generation Intel Core Processors (4XXXK and higher) and 
will not launch on previous Processors generation 
Recommended specification:  
https://confluence.merging.com/pages/viewpage.action?pageId=24608853 

 

 
Users that want to apply Windows updates may refer to the Merging Compatible Windows updates 

https://confluence.merging.com/pages/viewpage.action?pageId=25755762     
 

Note for Ovation keyboard users :  
Windows 10 1809 or 1903 requires ChangeMe version 5.25.8.  Previous versions will not work on Win10 
- 1809. 
Follow the installation instruction on our knowledge base to update : 
https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+guide 
 

 
 

 

Ovation v8.0 installation notes 
▪ As of Ovation v8.0, new Ovation v8 keys are mandatory 
▪ Ovation v8.0.5 HotFix come with a new MassCore RTX64 v3.7.0.4983 (different to the  
▪ The Ovation v8 installer comes only as a 64bit version (64bit OS) 
▪ Before you perform a Windows 10 update to Windows Fall Creator (1709) or Spring Creator 

(1803) or October update (1809) or May (1903) update on a system already running a 

MassCore version it will be important for users to remove MassCore from the MT Security 
MassCore tab prior to performing a system update. Details below 

Take note that when selecting uninstall MassCore you will need to reboot your system as the 
uninstallation is completed during the system reboot 

 
Note #1: We highly recommend users to defer the Windows updates, so that it does not 
harm your system here for details on how to defer updates 

Windows 10 users should never update to Beta Windows version or major new updates 
before making sure they are supported by Merging. 
 
Note #2:  
Users wanting to update to Windows May 1903 update must follow the procedure document  
https://confluence.merging.com/pages/viewpage.action?pageId=51118318 
Users that want to apply Windows updates may refer to the Merging Compatible Windows 
updates here  
Once you have updated your Windows 10, follow the Ovation v8 and MassCore installation. 

 

 
▪ SSK-HUD-RTX owners can have both an Ovation v7 MassCore and Ovation v8 MassCore Key 

stored on their dongle and go from a system to the other using their SSK-HUD-RTX 
▪ SSK-HUD-RTX owners should be aware that the Hasp driver 7.80 is not compatible with 

MassCore/RTX64. Refer to the procedure here: 

https://confluence.merging.com/pages/viewpage.action?pageId=24608853
https://confluence.merging.com/pages/viewpage.action?pageId=25755762
https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+guide
https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates
https://confluence.merging.com/pages/viewpage.action?pageId=51118318
https://confluence.merging.com/pages/viewpage.action?pageId=25755762
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https://confluence.merging.com/pages/viewpage.action?pageId=27852814  

 
Native Installation Notes:  

▪ As of Ovation v8 new Ovation v8 keys are mandatory 
▪ Ovation v8 can be installed on either Windows 7– 64bit or Windows 10 – 64 bit 
▪ The Windows 10 May update (1903) is supported as of Ovation v8.0.5 HotFix  
▪ It is necessary to remove the previous Pyramix version, if there is one, from the Windows 

Programs and Features, and then reboot your system before installing Ovation v8.  

▪ Follow the Ovation v8.0 Installation Guide for all details for the moment 
▪ Native users running Horus/Hapi on Firmware 3.9.4> must install and run ASIO v12.0.2. 
▪ The ANEMAN installer is no longer included in the Ovation Installer. 

In order to properly manage your audio network, it is highly recommended that you 
download and install the latest version of ANEMAN from 
http://www.merging.com/products/aneman/download 

 
 

MassCore Installation Notes: 

 
▪ Refer to the Ovation v8.0 Installation Guide for installation procedure and details on the 

specific BIOS settings and system configuration.  
▪ Ovation v8.0.5 HotFix uses a new MassCore version RTX64 v3.7.0 
▪ Ovation v8 MassCore users need a RTX64 3.0 key in order to Install and run MassCore. See 

with your Merging Sales Partners. 

▪ It is necessary to remove the previous Ovation version, if there is one, from the Windows 
Programs and Features, and then reboot your system before installing Ovation v8.  
Unless you are planning to update to; Windows 10 Creator (1703) or Fall Creator (1709) or 
Spring Creator (1803) or October update (1809) or May update (1903) it is recommended to 
first remove MassCore before performing the update. In such case follow the procedure 
document  

https://confluence.merging.com/pages/viewpage.action?pageId=51118318 

▪ After installing Ovation 8 MassCore users might need to uninstall their previous MassCore 

from the MT Security setting, MassCore Tab, depending on the previous Ovation version you 

were running. If there is an older version present you will be warned and required to reboot 
before updating to the latest version.  

▪ If your Ovation system never had a MassCore version before, users will have to install the 
new MassCore version from the MT Security Settings > MassCore tab. A valid MassCore 
RTX64 -3.0 key is mandatory. 

▪ Users running MassCore 64bit will not be able to move their license to another system (or the 
same system after a Windows re-installation) unless first making this demand through 

Merging keys@merging.com  Please justify the reason of your system migration or 
reinstallation as the RTX64 key is not meant to be frequently renewed. 
If Merging cannot follow up in a quickly enough (in case of emergency or during weekends) 
then please contact the Interval Zero (RTX) Sales team sales@intervalzero.com  
Note: MassCore/RTX 64bit keys are linked to the system/hardware. 
MassCore users can have their MassCore/RTX 64bit keys stored on a separate Dongle instead 

of having it linked to a unique system. Refer to the Merging option SSK-HUD-RTX. 

 
Refer to the Ovation v8.0 Installation Guide for more details 

https://www.merging.com/support/downloads#ovation 

 
Warning:  

▪ Windows 7 users could see this error: “ Installation of KB3033929 has failed”, potentially this 
update is already installed, proceed with YES 

▪ Additional Online installation notes are available here: 

https://confluence.merging.com/display/PUBLICDOC/Installation+Notes+v11  
 
 
Merging Windows 10 Configuration Guide 
https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration  
 

Note: At the Pyramix launch a warning message box will be displayed if your system updates settings 

are not configured upon Merging’s recommendations.  
 
Merging Windows 10 May Update 1903 update Configuration Guide 

https://confluence.merging.com/pages/viewpage.action?pageId=51118318 

 

https://confluence.merging.com/pages/viewpage.action?pageId=27852814
http://www.merging.com/products/aneman/download
https://confluence.merging.com/pages/viewpage.action?pageId=51118318
mailto:keys@merging.com
mailto:sales@intervalzero.com
https://www.merging.com/support/downloads#ovation
https://confluence.merging.com/display/PUBLICDOC/Installation+of+KB3033929+has+failed+error+message+during+installation
https://confluence.merging.com/display/PUBLICDOC/Installation+Notes+v11
https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration
https://confluence.merging.com/pages/viewpage.action?pageId=51118318
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Notes:  

▪ Anubis must be running  
▪ Anubis users must be running ASIO v12.0 and higher with ANEMAN 1.1.7 and higher. 
▪ For users with Ovation, Pyramix and VCube installed on the same system, it is mandatory 

that you upgrade to VCube 8.0 to run alongside Ovation 8.0 and Pyramix v12.0  
▪ MassCore RTX64 users upgrading their processor on a system that was running MassCore 

previously must follow a specific procedure, contact support@merging.com for more details. 
▪ A new MTCleanUp v11 utility is available through Merging’s Support for those having 

problems with their installation 
Please refer to the Knowledge Base 
https://confluence.merging.com/display/PUBLICDOC/MT+Cleanup  

 
 

mailto:support@merging.com
https://confluence.merging.com/display/PUBLICDOC/MT+Cleanup
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Ovation V8.0 Features 

 
▪ As of Ovation v8.0 new Ovation v8 keys are mandatory 

▪ Ovation v8 projects are not compatible with Ovation 7.1 

▪ Native users running Horus/Hapi on Firmware 3.9.4> must install and run RAVENNA ASIO 

driver v12.0.2. 

 

MassCore : 
Ovation v8.0.5 HotFix comes with a new MassCore Version RTX64 3.7.0.4983 supporting Windows 

10 October update 1903. 
 
Note: Native users running Horus/Hapi on Firmware 3.9.4> must install and run ASIO v12.0.2. 

 
 

Ambisonic Support 
 

 Ovation 8 now includes a complete hybrid Channel Based/Ambisonic workflow, allowing for 

 encoding, mixing, rotating and decoding Ambisonic signal directly in the mixing console. 

 

▪ Ambisonic up to the 7th order is fully supported, refer to VR Pack key information for all details. 

Internal Ambisonic channel numbering and normalization is AmbiX/SN3D. 

Note: use plugin for A to B format and Fuma to AmbiX conversion 

 

▪ The contextual menu in the Mixer for Strips > Add > Multi Channel Strip now offers the 7 

Ambisonic orders in the Channel Mapping list. 

 

▪ The contextual menu in the Mixer for Bus > Add > General Mixing Bus now offers the 7 

Ambisonic orders in the Channel Mapping list. 

 

▪ If a Channel based Strip crosses an Ambisonic Bus then the channel-based signal is encoded to 

Ambisonic and panned using the traditional Panner. Two additional sliders for Azimuth and 

Elevation are also displayed in this case in the Surround Panner window. A-Pan is displayed in 

the bus control component for the given Strip and Bus to indicate Ambisonic Panning. No 

Channel Routing is available in this case. 

 

▪ If a stereo or multichannel Strip crosses an Ambisonic Bus then the channel-based signal is 

encoded channel per channel to Ambisonic and panned using the traditional Panner using the 

same options (balance, dual pan, single pan with source size, etc…). Two additional sliders for 

Azimuth and Elevation are also displayed in this case in the Surround Panner window. A-Pan is 

displayed in the bus control component for the given Strip and Bus to indicate Ambisonic 

Panning. No Channel Routing is available in this case. 

 

▪ If an Ambisonic Strip crosses an Ambisonic Bus, there are two options available in the bus 

control, A-Mix and A-Rot. 

 

▪ A-Mix simply displays a diagonal in the Channel Routing window. This is for advanced usage. 

Keeping all values to 0.0 is recommended. 

 

▪ A-Rot displays a rotation tool both in the Panner bus and in the Surround Panner window. This 

allows rotating the Ambisonic Strip (the input scene) in the Ambisonic Bus (the output scene). 

 

▪ If an Ambisonic Strip crosses a Channel based Bus, then an Ambisonic Decoder is applied and 

the Ambisonic signal is decoded to the Speaker Set (or Channel Mapping) of the Bus. 

 



 
 

 
Merging Technologies Ovation 1.0 Release Notes 

▪ As for mixing, a choice is available to apply rotations before decoding (A-R+D), or only 

decoding (A-Dec) 

 

▪ Ambisonic Strips display an Ambisonic logo in the Panner bus for this strip and controls the Z 

rotation (see below). 

 

▪ The Surround Panning window (menu View > Windows/Tools > Surround Panner or CTRL + 

Click on the Panner Bus) now displays an Ambisonic logo as background if an Ambisonic bus is 

enabled for the selected Strip.  

 

▪ If both a Channel based bus and an Ambisonic bus are enabled for a given Strip, both the 

Ambisonic logo and the traditional Room Cube showing speakers are displayed. 

 

▪ In the Surround Panner window when an Ambisonic bus is display (showing the Ambisonic logo) 

a light Blue circle is played following the White square pan point. This is the Azimuth/Elevation 

equivalent of the X/Y/Z point, with a Radius of 1.0, being the intersection of a straight line 

between the pan point and the center of the sphere crossing the surface of the sphere. This is 

the Ambisonic Panned point. 

 
▪ The Surround Panning window offers a new Display Mode button allowing toggling between the 

traditional Top and Back views, a new Top and Cylindrical View and a new Cylindrical View only. 

 

▪ When manipulating the Cylindrical View, the Azimuth and Elevation is affected by the 

movements and the Radius is automatically maintained to 1.0, ensuring both the traditional 

panned point and the Ambisonic panned point to be located on the scene sphere surface. 

 

▪ When pressing CTRL while manipulating the Cylindrical View, the traditional panned point is 

forced to stick on the edges of the X/Y/Z cube (instead of the sphere) and therefore always 

moves on a straight line between speakers. This allows using the Cylindrical View in an optimal 

way when panning Channel based signal. 

 

▪ The ADM export available in the Mix-Down properly exports Ambisonic related information. 
 

Ambisonic Decoders: 

▪ Ambisonic Decoders supported up to 7th in v12, and the b<>com Decoders are now integrated 

within the Ovation mixer 

 

Additional changes: 
▪ The Standard Speaker Sets list (Channel Mapping list) available when creating a new Bus or a 

new Multi-channel Strip has been reorganized to match the latest industry standards. Most ITU-

R BS.2051-1 recommendation for loudspeaker configuration are now included in this list. 

▪ The Add Audio Track menu in the Timeline now offers the Standard Speaker Sets list when 

creating a new multi-channel Track & Strip 

 

New VR Pack Key option: 

▪ Ambisonic Strips and Ambisonic Groups of 1st and 2nd order are always decoded even if the VR 

Pack key is not present 

▪ Ambisonic Strips and Ambisonic Groups of 3rd to 7th order are properly decoded if the VR Pack 

key is present 

▪ Ambisonic Strips and Ambisonic Groups of 3rd to 7th order are decoded using a 2nd order 

decoder if the VR Pack key is NOT present 

 

 

Notes: 

▪ Ambisonic Strips and Busses can be created by the contextual menus of the Mixer or configure 

page 

▪ Ambisonic Bus channel types cannot be changed. 
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▪ External controllers can be used transparently to pan Ambisonic when encoding/panning 

Channel based to Ambisonic, the exact same controls are used. However Ambisonic Rotations 

use the rotations controls and should then be mapped separately to external controllers 
 

Known limitations: 

▪ The Divergence control has no effect in Ambisonic Encoding/Panning for now 

▪ Ovation Mixer currently does not allow multichannel connections for an Ambisonic input Strip 

for remote MicPre. Please use the Web Access PreAmps page for Horus and Hapi 

 

 

 
 

New “Playing Cues” window  

 

Available in the View menu 

▪ This window displays a copy of all currently playing, paused and dimmed cues in the system 

▪ They appear in the order of their fire time and they disappear when stopped 

▪ If the Cue Fire Buttons are enabled in the Show Properties, the playing cues can be paused and 

stopped directly from this window 

▪ Playing Cues window support on the Web Server 

Note: Auditioning Cues do not appear in the Playing Cues window. 
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HTTP Commands Support: 
▪ HTTP Commands can now be sent from Cues 

▪ In the Cue Properties the following data can be added: 

▪ HTTP Address: A valid IP address or host name 

▪ HTTP Port: A valid IP Port number 

▪ HTTP Fire Command: A command that will be sent to the above IP address and port 

when the cue fires 

▪ HTTP Pause Command: A command that will be sent to the above IP address and port 

when the cue pauses 

▪ HTTP Stop Command: A command that will be sent to the above IP address and port 

when the cue ends or stops 

 
 



 
 

 
Merging Technologies Ovation 1.0 Release Notes 

Ovation V8.0 Improvements 
 
Interaction Rule improvement: 

 

▪ An additional option is available when selecting a Cue List as the target for an Interaction Rule. 

▪ A choice has been added in the Interaction Rules dialog for targeting the First Cue of the target 

cue list (as before) or the currently Selected Cue in the target cue list. 

▪ Timed Cue List still run their internal timer when started with the First Cue / Timed Cue List 

Timer option. Standard Cue Lists run the First Cue in this case. 

▪ Both Standard and Timed Cue List now run the currently selected cue when the Selected Cue 

option is chosen, so Timed Cue List will NOT run their internal timer in this case. 
 

 

 Active Cue Window behavior changes: 

 

▪ Click in the trimmer scale: 

o If cue playing then jumps to the click point and keeps playing (NEW) 

o If cue auditioning then jumps to the click point and keeps auditioning (as before)  

 

▪ Click in a marker selects the marker (as before) 

▪ Click in a marker with ALT pressed: 

o If cue is playing then jumps to the marker and keeps playing (NEW) 

o If cue auditioning then jumps to the marker and keeps auditioning (NEW) 

Note: In order for the markers playback to be accurate the Cue Sampling Rate must be the 

same as the Ovation Show. Otherwise your cursor might start from the wrong location. 

 

▪ Double-click in the trimmer scale starts auditioning the cue from the click point (as before)  

▪ Double-click in a marker edits the marker rules (as before)  

▪ Double-click in a marker with ALT pressed starts auditioning from the marker (NEW) 

 

 

 New Cue Properties option 

 

▪ Cues now have a new option available in the Cue Properties: Fire at Show Start. Self-

explanatory, if this option is set to Yes, the cue will automatically fire when the show starts. 

 

 

 

New menus in Cue menu and right mouse click menu: 
 

▪ Copy Rules: copy the selected cue rules in the clipboard 

▪ Paste And Replace Rules: Replaces current rules of all selected cues with previously copied 

rules 

▪ Paste and Add Rules: Appends previously copied rules to all selected cues current rules 

 

 

 

A new ”Add Cue Shortcut” function 

 

▪ A new ”Add Cue Shortcut” function has been added in the Cue > Add Cue menu and Right 

Mouse Button menu 

▪ This function adds a new Cue having the same name, comment and color that a currently 

selected Cue with a Rule firing it when starting. This implements a Shortcut to the selected Cue. 
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Mixer improvements: 
 
 

As of Ovation v8.0.5 HotFix. 

 

Bus Sends 
▪ Mixing console General Aux/Group Busses Send Gain now allowed to go up to +12dB. 

▪ When send value is above 0 dB both the dB text indicator and slider turns to light red. 

 

Bus Trims 

▪ Mixing console General All Busses Trim Gain now allowed to go up to +20dB. 

▪ When trim value is above 0 dB the dB text indicator turns to light red. 

▪ Double click on any trim value reset to Mute if clicked on left side, or 0dB if clicked on right side 

 

 

Ovation v8.0.4 
 
▪ VCA Strips can now be moved anywhere in the Input Strips portion of the Mixer 

 

▪ Aux Group Strips can now be moved anywhere in the Input Strips portion of the Mixer 

 

▪ The General Mixing Bus section of the mixing console can now be operated as a big Matrix Grid. 

▪ Clicking on any On/Off button of the Send components and keeping dragging the mouse 

on any direction will create a diagonal patching (or unpatching) on neighbour 

components. 

▪ Pressing the CONTROL key while doing so will create a rectangular block of On/Off 

instead of a diagonal. Useful for quick unpatching of a region. 

▪ This feature is best used when the complete mixer is collapsed, both strips and busses, 

however still functional if some strips or bus are not. 

 

▪ Route page Save/Load 

▪ Added a Load and Save buttons in the Mixing Console Routing Page 

▪ This loads and saves the current console inputs, outputs and direct out routing from/to 

an XML file 

 

New Mixer scrolls 

 

▪ Added Mouse Wheel support in the Pyramix/Ovation mixing console. 

▪ Without modifiers the Busses are scrolled 

▪ With CONTROL modifier the Input Strips are scrolled if the mouse pointer is in the input 

strips area, or the Master Strips are scrolled if the mouse pointer is in the master strips 

area. 

 

▪ Masters and Busses can now be scrolled like Input Strips were in previous versions 

▪ Grabbing the Mixer LEFT border now reduces the Input Strips portion and those hidden 

can be scrolled 

▪ Grabbing the Mixer RIGHT border now reduces the Masters Strips portion and those 

hidden can be scrolled 

▪ Grabbing the Mixer TOP or BOTTOM border now reduces the Mix, Aux and Groups 

portion and those hidden can be scrolled 

 

▪ The bottom right contextual menu available on the [+] button now offers new entries: 

▪ Console > Reveal All: To maximize the Mixer window to reveal all Input Strips, Masters 

and Busses 

▪ Input Strips > Scroll Half: To reduce the currently visible Input Strips portion by half 

▪ Input Strips > Reveal All: To maximize the Mixer window to reveal all Input Strips 

▪ Masters > Scroll Half: To reduce the currently visible Masters Strips portion by half 

▪ Masters > Reveal All: To maximize the Mixer window to reveal all Masters Strips 
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▪ Busses > Scroll Half: To reduce the currently visible Mix/Aux Busses portion by half 

▪ Busses > Reveal All: To maximize the Mixer window to reveal all Mix/Aux Busses 

 

▪ This menu has been reorganized to show the entries in the following order: 

▪ Console 

▪ Input Strips 

▪ Masters 

▪ Busses 

 

▪ An additional section has been added to this menu: 

▪ Faders/Effects/Pan 

• Show All 

• Hide All 

• Collapse All 

This allows quickly Hiding/Collapsing and Showing back all Faders, Mutes, PreAmps, 

Effects and Pans at once to focus on a maximum of Busses available in the mixer height 

 Note: Users with controllers such as the Tango might see the AG displayed in their strip 

 section after being moved away, despite having control in the Aux Controller section. 

 

New. Mixer VST plugin Split by Columns layout option, to display all plugins at once instead of 

having them in flapping dialogs. 

 
 

Warning not all plugins might show up in columns if you have installed a very large plugins suite. 

 

ANEMAN 1.2.1: 

This new ANEMAN (Audio NEtwork MANager) version, include the following features. 

▪ New: MERGING+ANUBIS support 

▪ New: ZOEM support 

▪ New: support for Unicast 

▪ Discovery improvements 

▪ Zone Improvements 

▪ Quick access menu improvements 

▪ Improved stability 

▪ More details on www.aneman.net 

 

ANEMAN v1.2.1 Bugs fixed: 

▪ macOS Mojave 10.14.x Support 

▪ Improvement. Enhanced plugins discovery 

▪ Improvement. Device coloring for matrix 

▪ Improvement. Receiver deletion 

▪ Improvement. Device error now reported in the Matrix 

▪ Fixed. Plugin and Proxy installation issue 

▪ Fixed. Disabled Dock mode per default 

▪ Reliability fixes. 

 

Important: The ANEMAN comes as a separate installer. 

Please download and install the latest ANEMAN in order to manage and monitor your AoIP devices 

from https://www.merging.com/products/aneman 

 
Warning: RAVENNA Easy Connect is not supporting MERGING+ANUBIS, it is recommended to use 

ANEMAN to manage your Anubis AoIP network connections 

https://www.merging.com/products/aneman
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Fixed Bugs in Ovation v8.0.5 HotFix: 

 

▪ Improved editing reliability to prevent random crash (Ovation) 

▪ New: MassCore RTX64 3.7.0 update as of Ovation 8.0.5 HotFix 

▪ MassCore performance reliability and PTP synchronization improvements 

▪ PMX111-72: Fixed. Mixer/Record: Some mixer can become corrupted with wrong 

assignation to tracks in record 

▪ PMX120-100: Fixed. Mixer: Custom Plugin IO setup for user from the routing view (right 

click on plug-in node) 

▪ PMX120-110: Fixed. External Inserts makes PMX crash in some projects 

▪ PMX120-111: Fixed. Mixer Configure page resets the routing of Native Plug-ins instances 

▪ PMX120-118: Fixed. VST routing Crash Pyramix on some plugins when opening Routing 

configuration 

▪ PMX120-122: Fixed. Secondary Audio Device crashes Pyramix when clicking Apply Changes 

or OK buttons 

▪ PMX120-129: Fixed. Ambisonic Panner movement become sticky if you have multiple 

buses 

▪ PMX120-134: Fixed. Configuration Message 

▪ Fixed. Ovation playback buffer size initialization issue 

▪ Fixed. Bonjour (Un)Install prerequisites 

▪ Fixed. Room 3D Speaker set setup when dealing with discrete channel types 

▪ Fixed. Mixer configure page fix: Adding Stereo or mono strip does not take the specified 

channel types into account  

▪ Fixed. limitation for Ambisonic 

▪ Fixed. Mixer scrollbar contrast 

▪ Fixed. Bus sends improvements (goes to +12dB with level indicator) 

▪ Fixed. Bus trims improvements (goes to +20dB with level indication) 

▪ Fixed. Ovation: Increased number of available IP ports to 64 

 

 

 

 
Fixed Bugs in Ovation v8.0.4: 
 

▪ OV71-50: Fixed. Publish to Ovation Automation issues 

▪ PMX120-84: Fixed. MassCore RC1 overloads due to Mixer graphics 

▪ HEL-685: Fixed. Ovation improvements when launching and having pending states 

▪ Fixed. Ovation. Cosmetics fixes 

▪ Fixed. SELECT rule not selecting Cuelists 

▪ Fixed. Added Strip Name and Track Name in the Matrix Window 

▪ Fixed. Splashscreen text loading scrolls down and not visible 

 
 
Fixed Bugs in Ovation v8.0 RC1: 
 

▪ New Keys Pyramix v12 and Ovation v8 as of Release Candidate 1 

▪ OV71-8: Fixed. Fader Automation issue. 

▪ OV71-38: Fixed. Ovation cannot replace cues by MTFF ones  

▪ OV71-40: Fixed. New Copy/Paste Rules 

▪ OV71-40: Fixed. New menus in Cue menu and right mouse click menu 

▪ OV71-41: Fixed. New Cue properties option to Fire Cue at Show Start 

▪ OV71-48: Fixed. When jumping in a cue while playing, automation restarts from begining 

instead of jump point 

▪ OV71-49: Fixed. New Currently Playing Cues window 

▪ OV71-38: Fixed. Ovation cannot replace cues by MTFF ones (filtered out) 
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▪ GAIA-1023: Fixed. Cue record makes Ovation crash if no workspace 

▪ GAIA-1089:Fixed. GAIA-1023: Ovation crash in Exit when building waveforms in Active 

Cue dialog 

▪ PMX120-67: New. Added TransparencyCheck plugin in VS3 listing 

▪ RAV-976: Fixed. ASIO driver debug trace disabled (performance was impacted) 

▪ RAV-987: Fixed. SSM requires IGMPv3: disabled by default and move to an Hardware 

option (Horus, Hapi, Anubis) 

▪ Fixed. Added proper VST3 plug-ins scanning 

▪ Mixer enhancements. Matrix grid behavior for Buses and Auxes, Mixer Scrolling and 

Routing save/load presets. 

 
Fixed Bugs in Ovation v8.0 Beta2: 

 
▪ MSC-72: Fixed. Ovation v8 beta 1 - RTX3.6 install not working on Windows 7 if the update 

KB2921916 is not present (we’ve added this update to the Ovation installer) 

▪ HEL-785: Fixed. Issue with Ovation Mirrored commands - Custom Cue lists 

▪ OV71-38. Fixed. Ovation cannot replace cues by MTFF ones (filtered out) 

▪ PMX120-68: Fixed. Speed up VST3 Shell plug-in instantiation 

▪ Fixed. ASIO driver installation and uninstallation problems 

 
Fixed Bugs in Ovation v8.0 Beta1: 
 

▪ PMX120-12. Fixed. Strips with more than 8 channels cause Delay Compensation to corrupt 

the Mixer and might randomly crash 

▪ PMX120-19: Fixed. Mixer: Changing Ambisonic Bus order in configure Page does not 

update the 3D room 

▪ RAV-922: Fixed. Software devices: WebApp reconnects forever (due to MassCore NIC 

network interface custom name) 
▪ New. RefClk PTP traceable 

This feature is useful when you want to connect a stream through Internet (e.g. with two 

PTP Masters (GPS) at each locations), it allows to make connections with devices locked to 

different traceable PTP Masters. 

▪ OV71-30: Fixed. VST plugins not scanned at Ovation start. 

▪ HEL-777: Fixed. Ovation Active Cue - no audio if going back while playing 

▪ Fixed. Improved VST and VSt3 stability 

▪ Support for the Tipro Ovation keyboard on current Widnows update (1809) 

▪ Fixed. Advanced RAVENNA Settings Pages. Session sink were not accepting source name 

characters 

▪ Fixed. Advanced RAVENNA Settings Pages. Session Source: "enabled" property not 

restored during boot 

▪ Installer Update. SeaMax SDK update from v3.3.2.1 to v3.4.0.1 
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Technical Notes & Known Issues 
 
 

Merging online knowledge database for updates on the known issues 
https://confluence.merging.com/display/PUBLICDOC/Known+Issues  
 
 
General 

 
▪ Ovation v8 requires v8 keys (Pyramix v12 requires v12 keys) 
▪ WARNING: Ovation 8 is supported on 4th Generation Intel Core Processors (4XXXK and higher) and 

will not launch on previous Processors generation 
Recommended specification:  
https://confluence.merging.com/pages/viewpage.action?pageId=24608853 

▪ Note for Ovation keyboard users :  
Windows 10 October 2018 Update (1809) and May 2019 update (1903) requires 

ChangeMe version 5.25.8.  Previous versions will not work along those Win10 updates. 
Follow the installation instruction on our knowledge base to update : 
https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+gu
ide  

▪ Cue not starting up at times. Please make sure that your Media files are at the same 

sampling rate as your project. We recommend user to have their media files at the same 
sampling rate as their show. 

▪ When running an Ovation show with timed cue lists for more than 24 hours, it must be 
noted that any timed cue lists which are manually started (not chasing show time, but 
manually fired using the header in the timed cue list) will not behave properly. This is due 
to running multiples of a 24 hour clock. Using timed cue lists in every other fashion will 
work as normal in multiple day Ovation shows. 

▪ The SeaLevel GPIO's are no longer installed with the Pyramix software. Please refer to the 
page here for installations: 

https://confluence.merging.com/pages/viewpage.action?pageId=15139174 
 
 

MassCore 
▪ MassCore not supported on Core2Duo. Minimum requirement is a QuadCore. 

▪ MassCore is supported under Windows 7 (64bit) and Windows 10 (64bit) 
▪ Ovation v8.0.5 Hotfix comes with a new MassCore (RTX64 -3.7.0)  

 

 
Technical Notes: 

▪ MassCore not supported on Core2Duo since Ovation v4. Minimum requirement is a QuadCore. 
▪ MassCore is supported under Windows 7 (64bit) and Windows 10 (64bit) with Ovation v8 

▪ Ovation v8 system recommendations. Details here: http://www.merging.com/pages/pcconfig 
▪ MassCore 64bit: Activation key is linked to the system and not the dongle) and can only be activated 

once on a dedicated system. This only applies to 64bit. If you need to re-install MassCore/RTX64 bit 
on another system using the same key this will not be possible if the key has already been used. For 
such RTX64 Activation Key Replacement the demand can be made at keys@merging.com or in case of 
weekend emergency through the Interval Zero Support team IntervalZero Support site This means 

that if you already have install MassCore 64bit on system and want to move it to another system you 
must contact interval zero and RTX64 so that they re-issue the key. 

▪ In order to run MassCore 64bit users will need to have both the RTX64bit Activation key and the 
MassCore 64-bit key. 

▪ MassCore Ultra Low latency mode can generate noise if used on some configuration (not 
optimal/Turnkey recommended).  In such case we rather recommend to use the AES67 mode or the  
Extra Low latency mode. 

▪ Merging does not recommend the use Disk models: Green, Eco series and Seagate. 
▪ Merging recommend users with External USB disk to have those disks configured to “Better 

Performance” under Windows disk properties, profiling option. 
▪ The Network must be Layer 3 compliant and must be a Gigabit network 

▪ Merging has certified the Network Switch for use with Horus/Hapi – Ravenna find details and 
configuration file here: http://www.merging.com/products/horus/downloads 

▪ RAVENNA user should avoid connecting multiple Horus to any a router/Network not certified by 

Merging. Refer to the Merging RAVENNA Network Guide for all details on the certified RAVENNA switch 
and configuration. 

https://confluence.merging.com/display/PUBLICDOC/Known+Issues
https://confluence.merging.com/pages/viewpage.action?pageId=24608853
https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+guide
https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+guide
https://confluence.merging.com/pages/viewpage.action?pageId=15139174
http://www.merging.com/pages/pcconfig
mailto:keys@merging.com
http://nsvirtualurl.com/app/crm/marketing/campaignlistener.nl?__lstr=__cl&c=817159&__h=6edb2c94780a8b9a22a2&__r=99684&eou=aHR0cDovL3Nob3BwaW5nLm5ldHN1aXRlLmNvbS9pbnRlcnZhbHplcm8*&_od=aHR0cHM6Ly9mb3Jtcy5uZXRzdWl0ZS5jb20*&url=http://shopping.netsuite.com/intervalzero
http://www.merging.com/products/horus/downloads
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https://confluence.merging.com/display/PUBLICDOC/Network+Switches+for+RAVENNA+-+AES67  

http://www.merging.com/products/horus/downloads 
▪ Only RAVENNA devices can be connected to the Merging PCIe Ethernet Controller Card NET-MSC-

GBEX1. Avoid mixing up non-RAVENNA device on this network, like Controllers such as 
Tango/Isis/Euphonix or other network devices. The same will apply if you are connected to a Merging 
certified switch for RAVENNA use 

▪ Don’t connect a 100MB Ethernet device if the switch is not multicast; otherwise the flow control will 
reduce drastically the bandwidth. 

▪ A RAVENNA ASIO driver is available for Horus/Hapi users that wish to use their notebook GbE Network 
RJ-45 system socket. Refer to http://www.merging.com/products/horus/downloads 

 

 

Known issues: 
▪ RAVENNA Easy Connect is not supporting MERGING+ANUBIS, it is recommended to use ANEMAN to 

manage our AoIP network connections 
▪ Listing of Ovation supported remote controller here 

▪ Horus/Hapi Ravenna: Switching from MADI Standard (56) to MADI Extended (64) can generate small 
glitch, avoid doing so during realtime operations 

▪ Merging recommends the use of ANEMAN in order to manage all RAVENNA I/O connections, please 

refer to the ANEMAN User Manual installed along with Pyramix for more details. 
▪ Non-certified Ravenna configurations might not capable of sustaining 384 I/O @ 1FS (44.1/48 kHz). If 

you experience noise similar to static reduce the Ravenna I/O count enabled in ANEMAN 
▪ Merging recommends that Ravenna users disable the Windows Firewall, as it can partially block some 

of the Ravenna I/O connections 
▪ Peaks might show up under Pyramix Core section if you power OFF or disconnect the Horus/Hapi. 

Recommendation: A valid connection an online Horus is always required if the Horus/Hapi is PTP 
Master. Reset peaks by Mouse Clicking on the Core section. 

▪ Avoid changing a network address on your system or disconnecting Ethernet ports on your system 
when MassCore Ravenna is running 
Refer to the Easy Connect troubleshooting for more information 

https://confluence.merging.com/display/PUBLICDOC/RAVENNA+EasyConnect+Troubleshooting 
▪ Cannot use the ISIS since running Ravenna with the Merging PCIe Ethernet Controller Card  NET-MSC-

GBEX1 
Recommendation: Refer to the ISIS support document below  
http://download.merging.com/beta/SupportTools/Docs/ISIS_Vista_or_7_dedicated_lan.pdf 

 

Connections: 
In order to create RAVENNA I/O connections please refer to the ANEMAN guide or the RAVENNA Easy 
Connect guide (installed along with Ovation) 

 
Windows Firewall: 
The Windows Firewall can block communication between MassCore and Horus. We recommend users 

to disable the Public Network Firewall 
Procedure: 
1. Go in Windows Control Panel > Windows Firewall. 

2. Click on “Turn Windows Firewall on or off” 
3. Go to the Public Network section and select “Turn Off Windows Firewall” 
 

Windows UAC: 
User should disabled the Windows User Account Control 
Procedure: 
1. Go in Windows Control Panel\All Control Panel Items\User Accounts 
2. Open the Change User Account Setting 
3. And set it to never notify 

 

Disable Antivirus: 
Some Antivirus as Avast or Sophos  have been known to block the Horus discovery and RAVENNA I/O 
Connections. Merging also recommends that any Antivirus software is properly configured to not 
interfere with the DAW. See this page for further details: 
https://confluence.merging.com/display/PUBLICDOC/Antivirus+and+Merging+Technologies+Softwares  

  

 

 

https://confluence.merging.com/display/PUBLICDOC/Network+Switches+for+RAVENNA+-+AES67
http://www.merging.com/products/horus/downloads
http://www.merging.com/products/horus/downloads
https://confluence.merging.com/pages/viewpage.action?pageId=17203276
https://confluence.merging.com/display/PUBLICDOC/RAVENNA+EasyConnect+Troubleshooting
http://download.merging.com/beta/SupportTools/Docs/ISIS_Vista_or_7_dedicated_lan.pdf
https://confluence.merging.com/display/PUBLICDOC/Antivirus+and+Merging+Technologies+Softwares
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Ovation Native Recommendations: 

 

 
▪ Windows 7 and Windows 10 - 64bit supported with Pyramix, Ovation and RAVENNA ASIO v12. 
▪ Please refer to our Windows configuration guides to optimize system performance. 

▪ Administrator rights are required to configure VS3 Control Panel and the RAVENNA ASIO panel. 
▪ The Merging RAVENNA ASIO Frame Mode size can be configured to AES67 (6, 12, 48) of RAVENNA  

mode (64), 48 and 64 being recommended, verify your network and devices configuration. 
▪ The Merging RAVENNA ASIO driver can be set to buffer size multiples of 48 (AES67) or 64 samples 

(RAVENNA), adjust the buffer size to your system in order to get the best performance 
▪ Configure your Antivirus and Merging Technologies Softwares or turn it off 
▪ Configure your Windows Firewall Windows Firewall Troubleshooting or turn it off for Public 

Networks 
▪ Put Windows UAC (User Account Control) to the lowest level (disabled). 
▪ Disable the WIFI (disable the Wireless adaptor not only the WIFI connection) 
▪ Disable Bluetooth if active (under Windows Device Manager)  

▪ Set Windows Automatic-Update to “notify me” or don't let Windows check for Updates while 
running critical real-time operations on Windows 7. 
Set the updates to restart outside active hours on Windows 10. 

▪ Avoid active internet connection while running Pyramix  
▪ Avoid connecting audio interfaces to USB or Firewire hubs, plug it directly into your computer. 
▪ We recommend to activate HyperThreading if allowed by your CPU. 
▪ Power management features must be configured to get a stable system.  
▪ In Windows Control Panel > Power Options, make sure you select the “High Performance” power 

plan (or "Ultimate Performance" on Windows 10 Spring Creator 1803 and October update 1809, 

1903)(very common that Powerful laptop are at times in energy saving mode, create a High 
Performance power plan). 

▪ Avoid using battery power, rather have you power cable connected 
▪ Make sure all unnecessary programs are closed. They can tie up useful resources. 
▪ Turn off any software utilities that run in the background, such as Windows Messenger, calendars, 

and disk maintenance programs. 
▪ Laptops usually have small graphical resources, Merging recommends you pay extra caution when 

using the Fixed Cursor option.  
▪ Verify the performance of your Native system. 

On Windows 7 by running the DPC Latency 
checker: http://www.thesycon.de/eng/latency_check.shtml 
On Windows 10, DPC latencies can be monitored with Latency Mon 
http://www.resplendence.com/download/LatencyMon.exe 

▪ Laptop users should set their ASIO interface to Topmost Priority in VS3 Control Panel. 

 
 

 
Refer to the online documentation for more details 
https://confluence.merging.com/display/PUBLICDOC/Native+recommendations 
 

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide
https://confluence.merging.com/display/PUBLICDOC/Antivirus+and+Merging+Technologies+Softwares
https://confluence.merging.com/display/PUBLICDOC/Windows+Firewall+Troubleshooting
http://www.thesycon.de/eng/latency_check.shtml
http://www.thesycon.de/deu/latency_check.shtml
http://www.thesycon.de/deu/latency_check.shtml
http://www.resplendence.com/download/LatencyMon.exe
https://confluence.merging.com/display/PUBLICDOC/Native+recommendations

